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Technical Guide for Spreadsheet 
This document provides information about the functionalities of the widget for data entry and 
management. 

Conventions 
This guide uses the following conventions: 

Item Convention 

Buttons, menus, tabs, dialog titles boldface font 

Keyboard buttons, names of functions screen font 

Selection sequences of buttons or options Data > Data Validation  

Overview 
The Kendo UI Spreadsheet is used for the implementation of related data and its visualization in 
a tabular format (rows and columns). This kind of data structuring provides for an easier 
management and analysis. The widget renders the touch and feel of a Microsoft Excel table by 
offering many cell-formatting options, styles, and themes while utilizing simpler and easy-to-
master user interface. 

Figure 1: Main Elements of the Spreadsheet 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#user-guide
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#conventions
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#overview
https://support.office.com/en-ca/article/Overview-of-Excel-tables-7ab0bb7d-3a9e-4b56-a3c9-6c94334e492c
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Actions 

Sheets 

When you open the Spreadsheet, the widget automatically generates a worksheet and applies to 
it a collection of default settings. 

What you 
want 

How to get there 

Select 
Click Select All [ ] located to the left of column header A and above row header 
1 on the active sheet 

Create Click + on the Sheet Tab Bar to create a new sheet 

Rename 

1. Double-click the tab of the sheet you want to rename and modify it 
2. Press Enter to exit, or click anywhere on the sheet 

Reorder 
Click and hold the sheet tab, and drag it to the desired location on the Sheet 
Tab Bar 

Delete Click X [ ] on the tab of the sheet you want to remove 

Cells 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#actions
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#sheets
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#cells
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What you want How to get there 

Select/activate Click a cell 

Select a range of 
cells 

1. Click a cell 
2. Extend the selection by holding down the mouse while marking the 

selection you want 

Edit Double-click a cell 

Copy content 

1. Select a cell 
2. Click Copy [ ] on the Toolbar, or right-click the desired cell to display 

the context menu and choose Copy from it, or use the Ctrl + C 
keyboard shortcut 

Cut content 

1. Select a cell 
2. Click Cut [ ] on the Toolbar, or right-click the desired cell to display the 

context menu and choose Cut from it, or use the Ctrl + X keyboard 
shortcut 

Paste content 

1. Click the cell where you want to place the copied or cut content 
2. Click Paste [ ] on the Toolbar, or right-click the desired cell to display 

the context menu and choose Paste from it, or use the Ctrl + V 
keyboard shortcut 

Delete content 

1. Select a cell 
2. Press Delete on your keyboard to remove its content 

Align content 

1. Select a cell 
2. Click Alignment [ ] on the Toolbar  
3. Choose a style form the drop-down list 

Wrap content 

1. Select a cell that contains the content you want to wrap 
2. Click Wrap Text [ ] on the Toolbar  

Merge cells 

1. Select the cells you want to merge 
2. Right-click the selection > Merge  
3. Select the option from the Merge Cells pop-up window 

Merge cells (via 
Toolbar) 

1. Select the cells you want to merge 
2. Click Merge Cells [ ] on the Toolbar  
3. Choose an option from the drop-down list 

Add a background 
color 

1. Select a cell 
2. Click Background [ ] on the Toolbar  
3. Choose a color from the drop-down list to apply to the cell background 

Choose border styles 
and colors 

1. Select a cell 
2. Click Borders [ ] on the Toolbar  
3. Select the border style and/or the color from the drop-down list 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-shortcuts
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-shortcuts
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-shortcuts
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What you want How to get there 

4. Click anywhere on the sheet to exit 

Rows 

What you want How to get there 

Select/activate Click the row header against of the row you want to select 

Insert 

1. Select a row by clicking on the respective row header 
2. Click the Insert tab from the Menu  
3. Click Add Row Below [ ] or Add Row Above [ ] on the Toolbar  

Delete 

1. Right-click the row header 
2. Choose Delete  

Delete (via Toolbar) 

1. Select a row by clicking on its row header 
2. In the Menu click Insert  
3. On the Toolbar click Delete Row [ ] 

Hide 

1. Select the rows by clicking on the respective row header 
2. Right-click the row header 
3. Choose Hide  

Wrap content 

1. Select a row 
2. Click Wrap Text [ ] on the Toolbar  

Resize the height of a 
row 

1. Select a row or a cell from a row 
2. Hover the pointer over the row header field until either the upper or 

bottom field border is highlighted 
3. Click the highlighted area and hold while dragging it to the desired 

height. Release the hold. 

Add a background color 

1. Select a row 
2. On the Toolbar click Background [ ] 
3. Select the color from the drop-down list 

Choose border styles 
and colors 

1. Select a row 
2. Click Borders [ ] on the Toolbar  
3. Select the border style and/or the color from the drop-down list 
4. Click anywhere on the worksheet to exit 

Columns 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#rows
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#columns
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What you want How to get there 

Select/activate Click the column header against the column you want to select 

Insert 

1. Select a column by clicking on the respective column header 
2. Click the Insert tab from the Menu  
3. On the Toolbar click Add Column Left [ ] or Add Column Right [ 

] 

Delete 

1. Select the columns by clicking on the respective column header 
2. In the Menu click Insert  
3. On the Toolbar click Delete Column [ ] 

Hide 

1. Select a column by clicking on the respective column header 
2. Right-click the column header 
3. Choose Hide  

Wrap content 

1. Select the column whose content you want to wrap 
2. Click Wrap Text [ ] on the Toolbar  

Resize the width of a 
column 

1. Select a column or a cell within a column 
2. Hover the pointer over the column header field until either the left 

or right border is highlighted 
3. Click the highlighted area and hold while dragging it to the desired 

width. Release the hold. 

Add a background color 

1. Select a column 
2. On the Toolbar click Background [ ] 
3. Select the color from the drop-down list 

Choose border styles and 
colors 

1. Select a column 
2. Click Borders [ ] on the Toolbar  
3. Select the border style and/or the color from the drop-down list 
4. Click anywhere on the sheet to exit 

Fonts 

What you want How to get there 

Choose fonts 

1. Select the cells to which you want to apply the font 
2. On the Toolbar click Font [ ] 
3. Choose a font type from the drop-down list 

Edit font sizes 

1. Select the cells to which you want to apply the font size 
2. On the Toolbar click Font Size [ ] 
3. Choose the font size from the predetermined values in drop-down list 

Format fonts 1. Select the cells where you want to format the font 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#fonts
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What you want How to get there 

2. Use any of the following commands: 

o To make make the font bold, click Bold [ ] on the Toolbar  
o To make make the font italic, click Italic [ ] on the Toolbar  
o To make make the font underlined, click Underline [ ] on the Toolbar  

Filters 

What you 
want 

How to get there 

Sort fields 

1. Click Data on the Tab Bar  
2. Select a column 
3. Click Sort [ ] on the Toolbar and choose any of the two options from the drop-

down list: 

o Sort range A to Z sorts the content within the selected columns in ascending 
order 

o Sort range Z to A sorts the content within the selected columns in descending 
alphabetical order 

Unsort 
fields 

• Click Undo [ ] on the Menu to reverse the sorting you made. 

Оr 

• Add a new column. Check which is the last active field of the columns whose 
data you want to sort. Then add a subsequent number (1, 2, 3, etc.) to each field 
of the recently added column ending with the field in the same row as the last 
field of the columns whose content you want to sort. In this way you can revert 
the sorting of the target columns by applying the sorting option in ascending 
order to the recently added helper column. 

Filter 
information 

1. Click Data on the Tab Bar  
2. Select the columns to which you want to apply the filtering criteria 
3. Click Filter [ ] on the Toolbar  
4. Choose from the drop-down list of options: 

o Sort range A to Z sorts the data within the columns in ascending alphabetical 
order 

o Sort range Z to A sorts the data within the columns in descending alphabetical 
order 

o Filter by condition filters the data within the column by applying any of the 
conditions from the drop-down list of options. Each of them can be applied to text 
fields, dates, or numbers: 

▪ Text fields: Choose any of the options referring to texts from the Filter by 
condition drop-down list. Fill in the field below to set the filter condition. Click 
Apply. For example, choose Text starts with, set the condition to E, and click 
Apply. The result shows all rows containing text fields that start with an E. You 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#filters
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What you 
want 

How to get there 

can alphabetically sort the filtered information by clicking Sort range A to Z or 
Sort range Z to A. 

▪ Dates: Choose any of the options referring to dates from the Filter by condition 
drop-down list. Fill in the field below to set the filter condition. Click Apply. For 
example, choose Date is, set the condition to 6/30/2014, and click Apply. The 
result is a list of only rows containing fields that display the date 6/30/2014. Note 
that the date format may differ depending on the order of date components. 
Make sure you check the current format before applying this filter. 

▪ Numbers: Choose any of the options referring to numbers from the Filter by 
condition drop-down list. Fill in the field below to set the filter condition. Click 
Apply. For example, choose Is equal to, set the condition to 10230, and click 
Apply. The result is a list of only rows containing fields that display the number 
10230. 

To retrieve all applied filters and sorting conditions, from Filter by condition 
choose None > Apply. 

o Filter by value provides more options for filtering numbers. 
▪ Select the checkbox against All to clear all conditions and view all rows within 

the active sheet 
▪ Uncheck All to clear all checkboxes, and choose the values according to which 

you want to filter the data in the selected columns. 

File Import and Export 

You are able to export the content of your Spreadsheet to Portable Document Format (PDF) or 
Excel format (.xlsx) files, as well as import Excel Workbook content to the Spreadsheet. 

What 
you 
want 

How to get there 

Import 
files 

1. Click Open [ ] on the Toolbar. 
2. From the dialog box select the Excel Workbook you want to import by clicking on it. 
3. Click Open to load its content. 

Export 
files 

1. Click Export [ ]. 

Export to Excel  

2. In the File name field fill in a name for the file that is going to be exported.  

3. From the Save as type drop-down list choose Excel Workbook (.xlsx). 

4. Click Save to locally download the exported Excel file and follow your browser 
instructions to proceed further on. 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#file-import-and-export
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What 
you 
want 

How to get there 

Export in PDF  

2. In the File name field fill in a name for the file that is going to be exported.  

3. From the drop-down list against Save as type choose Portable Document 
Format (.pdf). 

4. From the Export drop-down list choose which part of the content you want to 
export—the entire workbook, active sheet, or a partial content selection. 

5. From the Paper size drop-down list pick the size in which you want the exported 
file to be displayed. 

6. From the Margins drop-down list select what the margins of the resulting pages—
normal, narrow, or wide. 

7. Indicate whether you want to display the content of the resulting file in a horizontal 
or vertical orientation by clicking on the respective icon. 

8. By checking Guidelines against Print, your exported PDF document is going to 
display its content in a table format with gridlines. If you want to disable the gridlines, 
uncheck the button. By default, Guidelines is checked for you to provide for the 
better visualization of the content. 

9. Checking the Fit to page option against Scale is going to automatically make the 
content from your spreadsheets fit within the boundaries of the exported PDF 
document. By default, Fit to page is checked for you to provide for the better 
visualization of the content. 

10. By checking the Horizontally option against Center, the content of the exported 
PDF file is going to be centered according to the horizontal margins of each exported 
sheet. By checking the Vertically option against Center, the content of the exported 
PDF file is going to be centered according to the vertical margins of each exported 
sheet. By default, both options are checked for you to provide for the better 
visualization of the content. 

11. Click Save to locally download the exported PDF file and follow your browser 
instructions to proceed further on. 

Other 

What you want How to get there 

Auto fill 

1. Insert textual, numeric, or textual and numeric characters of one and the 
same pattern in at least two subsequent column cells. For example, 1, 2. 

2. Select these cells. 
3. To copy the data series automatically, drag the fill handle across, down, or 

up the cells you want to fill. 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#other
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What you want How to get there 

Note that the Auto Fill command copies the format of the cells with the 
initial data series and will apply it to the target ones. 

If you select just one cell and drag the fill handle to auto-complete adjacent 
cells, the command copies, but does not change in the existing pattern, 
the content from the initial cell to each of the target ones. 

Freeze panes 

1. Select the row or column which you want to freeze 
2. From the Toolbar click Freeze Panes  
3. Choose the option from the drop-down list 

Apply the Undo 
function 

Click Undo [ ] on the Menu to reverse the actions you made during your 
current session. The number of actions you can reverse using Undo is 
unlimited. 

Apply the Redo 
function 

Click Redo [ ] on the Menu to repeat the actions you made during your 
current session. The number of actions you can repeat using Redo is 
unlimited. 

Increase decimal 
values 

Click Increase Decimal [ ] on the Toolbar to increase the number of digits 
after the decimal point 

Decrease decimal 
values 

Click Decrease Decimal [ ] on the Toolbar to decrease the number of 
digits after the decimal point 

Customize the 
format of numbers 

1. Select the cells where you want to format the font 
2. Click Custom Format [ ] on the Toolbar  
3. Select an option from the drop-down list. The style of formatting is hinted 

to the right of each option. 

Further customize 
the format of 
numbers 

1. Select the cells whose content you want to format 
2. Click Custom Format [ ] > More Formats. Choose any of the following 

options: 

o Number customizes the format of numerical input 
o Currency customizes the format of currency input 
o Date customizes the format of date input 

Apply formulas 
and functions 

1. Select a cell 
2. Go to the Formula Bar and type an equal sign [ = ] 
3. Type your formula/function and press Enter once done to see the outcome 

of your input in the cell. Note that when you start writing a function, the 
AutoComplete prompts you with the syntax. 

Edit formulas and 
functions 

1. Double-click a cell to display the formula/function in the Formula Bar  
2. Change the formula/function and press Enter  

Validate data 

Data validation allows you to predetermine the format and constrain the 
value of the content of a single cell or cells within a range, column, or row:  

1. Select a cell or a range of cells 
2. In the Menu click Data > Data Validation to open the Data Validation 

window 
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What you want How to get there 

3. Choose the criterion from the drop-down list of options. 
4. A new window with criteria-specific options appears. Use the prompts and 

drop-down options to set the rules for modifying the content. 

Choose data from 
predefined values 

The Spreadsheet supports the implementation of custom editors. They 
facilitate your input of data in a cell by providing you with predefined date 
and list values that are already placed in the necessary format. 

For example, if you are asked to fill in a date in a cell, clicking the icon of 
the custom editor of that cell provides you with a calendar. Choose the 
desired date without bothering about the syntax you are supposed to use 
to fill it in. 

1. Select a cell. 
2. An icon appears right next to it. Click on it to see the options that are 

predefined for you to choose from. 

Define names for 
cells and ranges 
of cells 

It is possible to define a custom name for a cell or a range of cells in the 
Spreadsheet. As a result, instead of typing the range in formulas later on, 
you can directly refer to the range by its name. 

1. Select a cell or a range of cells by using the mouse. For example, select 
the A1:C3 range. 

2. Click on the Name Box of the Spreadsheet. 
3. Type in the name of the range that is currently selected. For example, 

name the range MyRange. 
4. Press Enter. 
5. Go to a cell outside the range and type in the Formula Bar a formula 

which refers to the range by its name. For example, =SUM(MyRange)+2. 

Delete names of 
cells and ranges 
of cells 

1. Select the name of the cell or the range of cells from the Name Box. 
2. Click X. 

 

Important 

• To close an active drop-down list or menu or exit an open window and then return to the 
worksheet, click Cancel whenever displayed as a command. 

• To apply an options you have already selected, click Apply whenever displayed as a command. 

Formulas and Functions 
The Spreadsheet supports many of the Excel formulas and functions as seen in the List of 
Formulas and Functions. 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#formulas-and-functions
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-formulas
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-formulas
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Keyboard Navigation 
The Spreadsheet supports many of the Excel keyboard shortcuts as seen in the List of Keyboard 
Shortcuts. 

Known Limitations 

• Because of specific requirements, browsers might not support the Paste command when it is 
initiated from the context menu or from the Toolbar. If you try to apply the command in either of 
these ways, a popup message is displayed informing you about the limitation. Use the keyboard 
navigation to achieve the desired result. 

• Formulas that are very deeply nested, such as =sin(cos(sin(cos(...)))) or =A1+A2+A3+...+A200, 
might produce a stack overflow error. Even though the latter does not seem nested, it is internally 
treated as =((((...(A1+A2)+A3)+A4)+...+)+A200)). 

Solution 

Use SUM when your case is similar to the second example of the nested formulas above. If to 
use SUM is not possible, avoid nesting values more than 100 levels deep. Note that the 
maximum depth depends on the browser, but one hundred is considered to be a safe limit. 

  

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#keyboard-navigation
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-shortcuts
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-shortcuts
https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/user-guide#known-limitations
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List of Formulas and Functions 
The following table provides a list of the formulas and functions the Spreadsheet supports. 

Formulas and 
functions 

Description 

ABS Returns the absolute (nonnegative) value of a number 

ACOS 
Returns the principal value of the arccosine of a number. The angle is 
returned in radians. 

ACOSH 
Returns the principal value of the inverse hyperbolic cosine of a 
number 

ACOT 
Returns the principal value of the arccotangent of a number. The 
angle is returned in radians. 

ACOTH Returns the hyperbolic arccotangent of a number 

ADDRESS Returns a cell address (reference) as a text 

AGGREGATE Returns an aggregate of a list or database 

ARABIC Converts Roman numbers to Arabic as numbers 

AREAS Returns the number of areas in a reference 

ASIN 
Returns the principal value of the arcsine of a number. The angle is 
returned in radians. 

ASINH Returns the principal value of the inverse hyperbolic sine of a number 

ATAN 
Returns the principal value of the arctangent of a number. The angle 
is returned in radians. 

ATAN2 
Returns the principal value of the arctangent from x- and y- 
coordinates in radians 

ATANH 
Returns the principal value of the inverse hyperbolic tangent of a 
number 

AVEDEV Calculates the average of the absolute deviations of listed values 

AVERAGE Returns the average of a set of numbers 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-formulas#list-of-formulas-and-functions
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Formulas and 
functions 

Description 

AVERAGEA 
Returns the average of values, including numbers, text, and logical 
values 

AVERAGEIF Returns the average of all cells in a range based on a given criteria 

AVERAGEIFS Returns the average of all cells in a range based on multiple criteria 

BASE Converts a number into a text representation with the given base 

BETA.DIST Returns the beta cumulative distribution function 

BETA.INV 
Returns the inverse of the cumulative distribution function for a 
specified beta distribution 

BETADIST 
Returns the value of the probability density function or the cumulative 
distribution function for the beta distribution 

BINOM.DIST Returns the individual term binomial distribution probability 

BINOM.DIST.RANGE Returns the probability of a trial result using a binomial distribution 

BINOM.INV 
Returns the smallest value for which the cumulative binomial 
distribution is less than or equal to a criterion value 

BINOMDIST Returns the binomial distribution probability 

CEILING 
Rounds a number to the nearest integer or to the nearest multiple of 
significance 

CEILING.MATH 
Rounds a number up, to the nearest integer or to the nearest multiple 
of significance 

CEILING.PRECISE 
Rounds a number the nearest integer or to the nearest multiple of 
significance. Regardless of the sign of the number, the number is 
rounded up. 

CHAR Return character represented by a given number 

CHISQ.DIST Returns the cumulative beta probability density function 

CHISQ.DIST.RT Returns the one-tailed probability of the chi-squared distribution 
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Formulas and 
functions 

Description 

CHISQ.INV Returns the cumulative beta probability density function 

CHISQ.INV.RT 
Returns the inverse of the one-tailed probability of the chi-squared 
distribution 

CHISQ.TEST Returns the test for independence 

CHOOSE Uses an index to return a value from a list of values 

CLEAN Removes all nonprintable characters from a text 

CODE 
Return a numeric value corresponding to the first character in a text 
string 

COLUMN Returns the column number(s) of a reference 

COLUMNS Returns the number of columns in a given range 

COMBIN Returns the number of combinations for a given number of objects 

COMBINA 
Returns the number of combinations with repetitions for a given 
number of objects 

CONCATENATE Joins a number of text strings into one text string 

CONFIDENCE.NORM Returns the confidence interval for a population mean 

CONFIDENCE.T 
Returns the confidence interval for a population mean, using a 
Student's t distribution 

COS Returns the cosine of a number. The angle is returned in radians. 

COSH Returns the hyperbolic cosine of a number 

COT Returns the cotangent of an angle, specified in radians 

COTH Returns the hyperbolic cotangent of a number 

COUNT Counts the number of numbers in a list of arguments 

COUNTA Counts the number of values in a list of arguments 
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Formulas and 
functions 

Description 

COUNTBLANK Counts the number of blank cells in a range 

COUNTIF Counts the number of cells in a range that meet a criteria 

COUNTIFS Counts the number of cells in a range that meet multiple criteria 

COVAR Calculates the covariance between two cell ranges 

COVARIANCE.P Returns covariance, the average of the products of paired deviations 

COVARIANCE.S 
Returns the sample covariance, the average of the products 
deviations for each data point pair in two data sets 

CRITBINOM 
Returns the smallest value for which the cumulative binomial 
distribution is less than or equal to a criterion value 

CSC Returns the cosecant of an angle, specified in radians 

CSCH Returns the hyperbolic cosecant of an angle, specified in radians 

DATE Returns a date value constructed from a year, month, and day values 

DATEVALUE Returns the date converting it in the form of text to a serial number 

DAY Returns the day by converting it from a serial number 

DAYS Returns the number of days between two dates 

DAYS360 
Returns the number of days between two dates using the 360-day 
year 

DECIMAL 
Converts a text representation of a number in a given base into a 
decimal number 

DEGREES Converts radians to degrees 

DOLLAR Converts a number to text, using the $ currency format 

EDATE 
Returns the serial number of the date that is the indicated number of 
months before or after the start date 
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Formulas and 
functions 

Description 

EOMONTH 
Returns the serial number of the last day of the month before or after 
a specified number of months 

ERF Returns the error function 

ERFC Returns the complementary error function 

EVEN Rounds a number up to the nearest even integer 

EXACT 
Reports if two text values are equal using a case-sensitive 
comparison 

EXP Returns e raised to the power of a given number 

EXPON.DIST Returns the exponential distribution 

F.DIST Returns the F probability distribution 

F.DIST.RT Returns the F probability distribution 

F.INV Returns the inverse of the F probability distribution 

F.INV.RT Returns the inverse of the F probability distribution 

F.TEST Returns the result of an F-test 

FACT Return factorial of a number 

FACTDOUBLE Returns the double factorial of a number 

FALSE Returns logical value False  

FIND Returns the starting position of a given text 

FISHER Returns the Fisher transformation 

FISHERINV Returns the inverse of the Fisher transformation 

FIXED 
Rounds the number to a specified number of decimals and formats 
the result as a text 
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Formulas and 
functions 

Description 

FLOOR 
Rounds a number down to the nearest multiple of the second 
parameter 

FLOOR.MATH 
Rounds a number down, to the nearest integer or to the nearest 
multiple of significance 

FLOOR.PRECISE 
Rounds a number down to the nearest integer or to the nearest 
multiple of significance. Regardless of the sign of the number, the 
number is rounded down. 

FORECAST Assumes a future value based on existing x- and y- values 

FORMULATEXT Returns the formula at the given reference as text 

FREQUENCY Returns a frequency distribution as a vertical array 

GAMMA Return Gamma function value 

GAMMA.DIST Returns the Gamma distribution 

GAMMA.INV Returns the inverse of the Gamma cumulative distribution 

GAMMALN Returns the natural logarithm of the Gamma function 

GAUSS Returns 0.5 less than the standard normal cumulative distribution 

GCD Returns the greatest common divisor (GCD) 

GEOMEAN Returns the geometric mean of a sequence 

HARMEAN Returns the harmonic mean of a sequence 

HLOOKUP 
Looks for a matching value in the first row of a given table, and 
returns the value of the indicated row 

HOUR Converts a serial number to an hour 

HYPERLINK Creates a hyperlink involving an evaluated expression 

IF Returns one of two values, depending on a condition 
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Formulas and 
functions 

Description 

IFERROR 
Returns a specified value if a formula evaluates to an error; otherwise, 
returns the result of the formula 

INDEX Returns a value or a reference to a value from within a table or range 

INDIRECT Returns a reference indicated by a text value 

INT Rounds a number down to the nearest integer 

INTERCEPT Returns the intercept of the linear regression line for the given data 

ISBLANK Returns True if the referenced cell is blank; else returns False  

ISERR Returns True if the value is any error except #N/A; else returns False  

ISERROR Returns True if the value is any error; else returns False  

ISEVEN Returns True if the value is even; else returns False  

ISLOGICAL Returns True if the value is logical; else returns False  

ISNA Returns True if the value is the #N/A error; else returns False  

ISNONTEXT Returns True if the value is not text; else returns False  

ISNUMBER Returns True if the value is a number; else returns False  

ISO.CEILING 
Returns a number that is rounded up to the nearest integer or to the 
nearest multiple of significance 

ISODD Returns True if the value is odd; else returns False  

ISOWEEKNUM Returns the ISO week number of the year for a given date 

ISREF Returns True if the value is a reference; else returns False  

ISTEXT Returns True if the value is text; else returns False  

KURT Returns the kurtosis (“peakedness”) of a data set 
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Formulas and 
functions 

Description 

LARGE Finds the nth largest value in a list 

LCM Returns the least common multiple 

LEFT Returns a selected number of text characters from the left 

LEN Returns the number of characters from a given text 

LINEST 
Returns the parameters of a (simple or multiple) linear regression 
equation for the given data and, optionally, statistics on this 
regression 

LN Returns the natural logarithm of a number 

LOG Returns the logarithm of a number to a specified base 

LOG10 Returns the base-10 logarithm of a number 

LOGEST 
Returns the parameters of an exponential regression equation for the 
given data obtained by linearizing this intrinsically linear response 
function and returns, optionally, statistics on this regression 

LOGNORM.DIST Returns the cumulative lognormal distribution 

LOGNORM.INV Returns the inverse of the lognormal cumulative distribution 

LOWER Converts text to lowercase 

MATCH 
Finds an item in a range of cells, and returns its relative position 
(starting from 1) 

MAX Returns the maximum value in a set of numbers 

MDETERM Returns the determinant of a matrix 

MEDIAN Returns the median (middle) value in a list of numbers 

MID 
Returns a specific number of characters from a text string, starting at 
a specified position 

MIN Returns the minimum value in a set of numbers 
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Formulas and 
functions 

Description 

MINUTE Converts a serial number into a minute 

MINVERSE Returns the inverse of a matrix 

MMULT Returns the matrix output of two arrays 

MOD 
Returns the remainder when one number is divided by another 
number 

MODE.MULT 
Returns a vertical array of the most frequently occurring, or repetitive 
values in an array or range of data 

MODE.SNGL Returns the most common value in a data set 

MONTH Converts a serial number to a month 

MROUND Rounds the number to the desired multiple 

MULTINOMIAL Returns the multinomial for a given set of values 

MUNIT Creates a unit matrix of a specified dimension 

N Returns the number of a value 

NA Returns the error value #N/A  

NEGBINOM.DIST Returns the negative binomial distribution 

NEGBINOMDIST Returns the negative binomial distribution 

NETWORKDAYS Returns the number of whole workdays between two dates 

NORM.DIST Returns the normal cumulative distribution 

NORM.INV Returns the inverse of the normal cumulative distribution 

NORM.S.DIST Returns the standard normal cumulative distribution 

NORM.S.INV Returns the inverse of the standard normal cumulative distribution 
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Formulas and 
functions 

Description 

NOT Reverses the logic of its argument 

NOW Returns the serial number of the current date and time 

ODD 
Rounds a number up to the nearest odd integer, where "up" means 
"away from 0" 

OFFSET Modifies the position and dimension of a reference 

PEARSON Returns the Pearson correlation coefficient of two data sets 

PERCENTILE Calculates the x-th sample percentile of values in a range 

PERCENTILE.EXC 
Returns the k-th percentile of values in a range, where k is in the 
range 0..1, exclusive 

PERCENTILE.INC Returns the k-th percentile of values in a range 

PERCENTRANK Returns the percentage rank of a value in a sample 

PERCENTRANK.EXC 
Returns the rank of a value in a data set as a percentage (0..1, 
exclusive) of the data set 

PERCENTRANK.INC Returns the percentage rank of a value in a data set 

PHI 
Returns the value of the density function for a standard normal 
distribution 

PI Returns the approximate value of pi 

POISSON.DIST Returns the Poisson distribution 

POWER Returns the result of a number raised to the power of another number 

PROB Returns the probability that values in a range are between two limits 

PRODUCT Multiplies the set of numbers, including all numbers inside ranges 

PROPER Capitalizes the first letter in each word of a text value 

QUARTILE Returns the quartile of a data set 
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Formulas and 
functions 

Description 

QUARTILE.EXC 
Returns the quartile of the data set, based on percentile values from 
0..1, exclusive 

QUARTILE.INC Returns the quartile of a data set 

QUOTIENT Returns the integer portion of a division 

RADIANS Converts degrees to radians 

RAND Returns a random number between 0 (inclusive) and 1 (exclusive) 

RANDBETWEEN Returns a random number between specified values 

RANK Returns the rank of a number in a list of numbers 

RANK.AVG Returns the rank of a number in a list of numbers 

RANK.EQ Returns the rank of a number in a list of numbers 

REPLACE Replaces characters within text 

REPT Repeats text a specified number of times 

RIGHT Returns the rightmost characters from a text value 

ROMAN Converts Arabic numbers to Roman as text 

ROUNDDOWN 
Rounds a number down, towards zero, to the number of digits 
specified by digits  

ROUNDUP 
Rounds a number up, away from 0 (zero), to the number of digits 
specified by digits  

ROW Returns the row number(s) of a reference 

ROWS Returns the number of rows in a reference 

RSQ 
Returns the square of the Pearson product moment correlation 
coefficient 

SEARCH Finds a text value within another text value (not case-sensitive) 
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Formulas and 
functions 

Description 

SEC Returns the secant of an angle specified in radians 

SECH Returns the hyperbolic secant of a given angle specified in radians 

SECOND 
Converts a serial number to a second. This function presumes that 
leap seconds never exist. 

SERIESSUM Returns the sum of a power series based on the formula 

SIGN Returns the sign of a number 

SIN Returns the sine of an angle specified in radians 

SINH Returns the hyperbolic sine of a number 

SLOPE Calculates the slope of the linear regression line 

SMALL Finds the n-th smallest value in a data set 

SQRT Returns a positive square root of a number 

SQRTPI Returns the square root of a number multiplied by pi 

STDEV.P Calculates the standard deviation based on the entire population 

STDEV.S Estimates the standard deviation based on a sample 

STEYX 
Returns the standard error of the predicted y-value for each x in the 
regression 

SUBSTITUTE Substitutes new text for old text string 

SUBTOTAL Evaluates a function on a range 

SUM Sums (adds) the set of numbers, including all numbers in a range 

SUMIF Sums the values of cells in a range that meet a criteria 

SUMIFS Sums the values of cells in a range that meet multiple criteria 
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Formulas and 
functions 

Description 

SUMPRODUCT Returns the sum of the products of corresponding array elements 

SUMSQ 
Sums (adds) the set of squares of numbers, including all numbers in a 
range 

SUMX2MY2 
Returns the sum of the difference between the squares of 
corresponding values in two arrays 

SUMX2PY2 Returns the sum of squares of corresponding values in two arrays 

SUMXMY2 Returns the sum of squares of corresponding values in two arrays 

T Converts its arguments to text; else returns a 0-length text value 

T.DIST 
Returns the Percentage Points (probability) for the Student t-
distribution 

T.DIST.2T 
Returns the Percentage Points (probability) for the Student t-
distribution 

T.DIST.RT Returns the Student's t-distribution 

T.INV 
Returns the t-value of the Student's t-distribution as a function of the 
probability and the degrees of freedom 

T.INV.2T Returns the inverse of the Student's t-distribution 

T.TEST Returns the probability associated with a Student's t-test 

TAN Returns the tangent of a number in radians 

TANH Returns the hyperbolic tangent of a number 

TEXT Formats a number and converts it to text 

TIME Constructs a time value from hours, minutes, and seconds 

TIMEVALUE Returns the serial number of a particular time 

TODAY Returns the serial number of today's date 
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Formulas and 
functions 

Description 

TRANSPOSE Returns the transpose of an array 

TRIM 
Removes spaces from text; replaces all internal multiple spaces with a 
single space 

TRIMMEAN 
Returns the mean of the interior of a data set, ignoring a proportion of 
high and low values 

TRUE Returns the logical value True  

UNICHAR 
Returns the character represented by the given numeric value 
according to the Unicode Standard  

UNICODE 
Returns the Unicode code point that corresponds to the first character 
of a text value 

UPPER Converts text to uppercase 

VALUE Converts a text argument to a number 

VAR.P Calculates variance based on the entire population 

VAR.S Estimates variance based on a sample 

VLOOKUP Looks for a matching value in a table or a range by row 

WEEKDAY Converts a serial number to a day of the week 

WEEKNUM Determines the week number of the year for a given date 

WORKDAY 
Returns the date serial number which is a specified number of work 
days before or after an input date 

YEAR Converts a serial number to a year 

YEARFRAC 
Extracts the number of years (including fractional part) between two 
dates 

For more information on how to create formulas and what their syntax is, see the list of Excel 
functions. 

http://unicode.org/standard/standard.html
http://unicode.org/standard/standard.html
https://support.office.com/en-GB/article/Excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb?CorrelationId=343eb30b-8175-4479-be19-1310dd12334f
https://support.office.com/en-GB/article/Excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb?CorrelationId=343eb30b-8175-4479-be19-1310dd12334f
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Array Formulas 
Similar to Excel, the Kendo UI Spreadsheet supports array formulas which return a matrix of 
values. You have to enter them in the same way as in Excel—by pre-selecting the target range 
and pressing Ctrl+Shift+Enter to save the formula. 

  

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-formulas#array-formulas
https://support.office.com/en-us/article/Guidelines-and-examples-of-array-formulas-7d94a64e-3ff3-4686-9372-ecfd5caa57c7?ui=en-US&rs=en-US&ad=US
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List of Keyboard Shortcuts 
The following table provides a list of the keyboard shortcuts the Spreadsheet supports. 

Shortcuts Description 

Ctrl + A  Selects the whole worksheet 

Ctrl + C  Copies selected cells 

Ctrl + P  Displays the Print dialog box 

Ctrl + S  Saves the active spreadsheet file 

Ctrl + V  Inserts copied or cut cells to a selected location within the worksheet 

Ctrl + X  Cuts selected cells 

Ctrl + Y  Repeats the last action, if possible by using the Redo command 

Ctrl + Z  
Reverses the last action or deletes the last typed entry by using the Undo 
command 

Ctrl + select a 
cell 

Selects an adjacent or non adjacent cell 

Ctrl + select cells 
Selects a range of adjacent or nonadjacent cells. To simultaneously select 
more than one range of cells, repeat this command. The selected ranges 
can also overlap. 

Ctrl + select a 
row or column 

Selects an adjacent or nonadjacent row or column. 

Ctrl + select 
rows or columns 

Selects a range of adjacent or nonadjacent rows or columns. To 
simultaneously select more than one range of rows or columns, repeat this 
command. The selected ranges can also overlap. 

Esc Cancels an entry in a cell or in the Formula Bar  

Arrow keys Move a cell up, down, left, or right in a worksheet 

Ctrl + Arrow key Moves to the edge of the current data region of the active worksheet 

Shift + Arrow key 
Selects (a range of) adjacent cells, rows, or columns, by extending the 
selection by one cell, row, or column 

https://docs.telerik.com/kendo-ui/controls/data-management/spreadsheet/end-user/list-of-shortcuts#list-of-keyboard-shortcuts
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Shortcuts Description 

Ctrl + Shift + 
Arrow key 

Extends the selection of cells to the last nonblank cell in the same row or 
column as the active cell 

Down Arrow / Up 

Arrow key 

• Selects the next or previous command when a menu or submenu is open 
• In a dialog box, the arrow keys move between options in an active drop-

down list, or between options in a group of options 

Backspace 

• Deletes one character to the left in the Formula Bar  
• Removes the content of the active cell 
• In cell editing mode, it deletes the character to the left of the insertion point 

Delete 

• Removes the content from selected cells without affecting cell formats 
• In cell editing mode, it deletes the character to the right of the insertion point 

End 

• Goes to the far right cell of the active row 
• Selects the last command on a visible and active menu or submenu 

Ctrl + End  

• Moves to the last cell on a worksheet, in the lowest used row of the used 
column on the far right 

• If the cursor is in the formula bar, Ctrl + End moves the cursor to the end of 
the text 

• Ctrl + End moves to the last cell on a worksheet, in the lowest used row of 
the used column on the far right 

Ctrl + Shift + End  

• Extends the selection of cells to the last used cell on the worksheet located 
in lower-right corner 

• If the cursor is in the formula bar, Ctrl + Shift + End selects all text in the 
formula bar from the cursor position to the end 

Enter 

• Completes a cell entry from the cell or the Formula Bar, and selects the cell 
below 

• In a data form, it moves to the first field in the next record 
• Opens a selected menu or performs the action for a selected command 
• In a dialog box, it performs the action for the default command button in the 

dialog box (the button with the bold outline) 

Esc 

• Cancels an entry in the cell or Formula Bar  
• Closes an open menu or submenu, dialog box, or message window 

Home 

• Moves to the beginning of a row in a worksheet 
• Selects the first command on the menu when a menu or submenu is visible 

Ctrl + Home  Moves to the beginning of a worksheet 

Ctrl + Shift + 
Home  

Extends the selection of cells to the beginning of the worksheet 

Page Down Moves one screen down in a worksheet 

Page Up Moves one screen up in a worksheet 
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Shortcuts Description 

Spacebar 
In a dialog box, performs the action for the selected button, or selects or 
clears a check box 

Alt + Spacebar  Displays the Control menu for the Spreadsheet window 

Tab 

• Moves one cell to the right in a worksheet 
• Moves to the next option or option group in a dialog box 
• Moves a cell within an active range of cells, rows, or columns. 

Shift + Tab  
Moves to the previous cell in a worksheet or the previous option in a dialog 
box 

 


